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ADDING A COMMENT TO AN ARCHIVE

The Comments button and Edit|Comments... menu item are used to add, delete, edit,
or read a comment for a ZIP archive. Comments may be added to any ZIP archive (except 
Multi-volume). By default, PROZip will display the comment when an archive with a 
comment is opened. See Setting Archive Preferences.
The comment dialog below is displayed along with the current comment if one already 
exists. Type in any comment you wish to add to the archive and press the OK button. To 
remove the comment press the Clear button. To exit the dialog without saving any changes 
to the comment press the Cancel button. The Comments button will stay depressed to 
indicate the presence of a comment in the archive.
Archives that have been made self-extracting can still contain a comment which can be 
viewed with PROZip. However, the comment will not be displayed when the executable is 
run.
Click on the parts of the box below where  appears for more information.

See Also
Adding Files to an Archive
Deleting Files from an Archive
Extracting Files from an Archive



ADDING FILES TO AN ARCHIVE

The add files button and Edit|Add... menu item are used to add files to a ZIP archive. 
When the Add Files dialog is displayed, select the files to be added from the Files listbox and 
press the OK button. At least one file must be selected. Note that wildcards (e.g., *.*) cannot
be used to select files.
Click on the parts of the box below where appears for more information.

See Also
Adding Files to an Archive with Drag and Drop 
Deleting Files from an Archive
Drag and Drop
Extracting Files from an Archive



ADDING FILES TO AN ARCHIVE WITH DRAG AND DROP
To add files or a directory to an archive using drag and drop:

1.    Select the desired directory (3) or files (4) from a PROFile Manager Window. See 
Selecting Files.

2.    Click and drag the selected files and drop them on the desired Archive Window
A.    If files (4) are dropped onto the Archive File Pane (2), then those files will be 

placed in the directory currently being displayed.
B.    If a directory (3) is dropped onto the Archive File Pane, then all files in that 

directory and in all its subdirectories will be flattened (i.e., all directory 
information/structure will be discarded) and all files will be placed in the 
directory currently being displayed.

Click on the parts of the window below where appears for more information.

C.    If files (4) are dropped on the Archive Directory Pane (1) and the Relative Path 
Names options is specified in the Setting Archive Preferences dialog, the files 
are placed directly into the directory onto which they were dropped. If instead, 
the Full Path Names option is selected, then the full directory structure that 
originally contained the dropped files will be added to the archive starting at 
the directory onto which the files were dropped. For example, if the 
squares.bmp file is dropped onto the test.zip archive, and the Full Path option is
set, then an azprotmp directory with a myfiles subdirectory would be created 
and squares.bmp    would be placed in the new azprotmp/myfiles directory.

D.    If directories are dropped on the Archive Directory Pane (1) the path to the 
dragged directories is added to the name of the directory on which the items 
are dropped. The path name that is added depends on the setting specified in 
the Setting Archive Preferences dialog. If Relative Paths has been specified, 
dragging the myfiles directory (3) and dropping it onto test.zip (1) would cause 
a myfiles directory to be created in the archive (as in the illustration). All the 
files in the original myfiles directory would be placed in the newly created 



myfiles directory of the archive. If instead, the Full Path names option has been 
selected, an azprotmp directory with a myfiles subdirectory would be created. 
All the files that were originally in the myfiles directory would be placed in the 
myfiles subdirectory in the archive. In either case, all subdirectories of the 
dropped directory would also be archived.

As noted in the Drag and Drop section, hold down the <Alt> key while dropping to move 
the source files or directory instead of copying them. This will permanently delete the 
original files.
NOTE: Dragging and dropping a directory is usually faster than dragging and dropping all 
the files in a directory.

See Also
Adding Files to an Archive
Drag and Drop
Extracting Files from an Archive with Drag and Drop
Full and Relative Paths 



Archive Addition Exclusion Options

Files that match the descriptions here are never added to the archives. This is useful 
because whole directories can be selected and added to an archive without archiving 
every file in the directory. For example, suppose you create temporary files with a tmp 
extension in a directory, but you never want to archive them. Type "*.tmp" in the Exclude 
edit box, and when you archive the directory that contains them they will not be added to 
the archive. Beware, this can result in not archiving files that you may want archived. 
Separate each exclusion entry with a space in the edit box.
Example:
*.sav      prozip.*      temp.tmp
will cause all files with a sav extension, all files that have prozip as the base filename, and
temp.tmp not to be added to an archive.



Archive Addition Options

These options specify the circumstances under which you are prompted when adding files 
to an archive if files with the same names already exist in the archive.

Always Overwrite Automatically overwrite the previous file in the archive 
without prompting.

Prompt before Overwrite Prompt for confirmation before overwriting an existing file 
in the archive.

Never Overwrite Leave the existing file in the archive (do not replace it).
Overwrite if Newer Automatically overwrite the existing file in the archive 

without prompting if the file being added is more recent 
than the file in the archive.



Archive Compression Options

Specify the compression level to be used when adding files to an archive    The valid range
is 0 to 9 with 9 being the highest compression (and slowest to compress) and 0 being no 
compression at all (useful for simple archiving purposes). The default value of 5 is often 
the best compromise between size and speed.



Archive Deletion Options

These options specify the circumstances under which you are prompted when deleting 
files from an archive. These options apply when deleting files from an archive and when 
moving files from an archive to a disk during an extraction operation. 
PLEASE NOTE: There is no "undelete" in PROZip so files deleted from archives are 
deleted forever. Therefore, it is safest to set this option to "Always Prompt".

Always Prompt Prompt for confirmation before deleting a file from an archive
Never Prompt Delete files from an archive without confirmation



Archive Directory Pane

This pane shows the directories in the archive. To display the files in a directory, click on 
the desired directory. To "expand" the directory and display its subdirectories, double-click
on it. Double-click on the directory again to "collapse" it (remove the display of its 
subdirectories).



Archive Extraction Options

These options specify the circumstances under which you are prompted when extracting 
files from an archive if files with the same names already exist in the directory being 
extracted to.

Always Overwrite Automatically overwrite the existing file in the directory 
without prompting.

Prompt before Overwrite Prompt for confirmation before overwriting the existing file 
in the directory.

Never Overwrite Leave the existing file in the directory (do not replace it).
Overwrite if Newer Automatically overwrite the existing file in the directory 

without prompting if the file being added is more recent 
than the file in the directory.



Archive Files Selected

This box shows the total number of files selected in the archive.



ARCHIVE WINDOW
Each archive window displays the contents of a single ZIP file; multiple ZIP files may be 
opened simultaneously. An Archive Window contains two sub-windows: a directory pane 
(left side) and a file pane (right side) showing the currently selected directory within the 
archive. Standard archive windows are shown with yellow folder and file icons, self-
extracting archives are shown with green icons, and multi-volume archives that have 
already had files placed in them (are completed) are shown with red icons. To change the 
width of the panes, drag the splitter bar (gray rectangle) that separates the panes in the 
desired direction. Column header buttons at the top of the file pane can be clicked on to 
quickly sort the files. To reverse sort the files, click on the button again. Files may also be 
sorted by selecting items from the View Menu.

Click on the parts of the box below where appears for more information.

See Also
Adding Files to an Archive 
Copying and Moving Files between Archives 
Extracting Files from an Archive 
Multi-Volume Archive 
Setting Archive Window Preferences 



Association Description

Type in a description for the association being created here.



Association Extension

Type in the extension you want to create an association for here.



Association Program

Type in the name of the program to associate with the file extension here. The Browse... 
button may also be used to select the program.



Attributes Check Box

The file attributes (such as read-only) are displayed if this check box has an 'X'.



Browse Button

This button is used to search the disk for a program name.



Cancel Button

Click on this button to cancel the current action.



Clear Button

Click this button to delete the comment from the archive.



Clear Passwords

Use this button to clear the encryption and decryption passwords. 



Comment Edit Box

Type in (or edit) the archive's comment in this box.



Compressed Size Check Box

Place an "X" in this check box to display the column containing compressed sizes.



Compression Ratio Check box

Place an "X" in this check box to display the column showing compression ratios.



CONTEXT-SENSITIVE HELP

The context-sensitive help toolbar button and <Shift>+<F1> keys are used to put 
the program into context-sensitive help mode. The cursor changes to 

. Once the program is in context-sensitive help mode, click on any item (tool bar button, 
menu item, or window) to get information about that item.

See Also
General PROZip Information
Help Menu 



COPYING AND MOVING FILES BETWEEN ARCHIVES
Because PROZip has the unique ability to open and use multiple archives simultaneously. 
You can copy or move files and directories between archives. To copy files or directories 
between archives:

1.    Select the desired directory (1) or files (2) from the source Archive Window. See 
Selecting Files.

2.    Click and drag the selected item(s) and drop them on the desired destination 
Archive Window.

A.    If directories are dropped on the Archive Directory Pane (3) of another 
archive the source path is appended to the name of the directory on which 
the items are dropped. Either the full path name or the relative path name of
the file is appended depending on which option is selected in the Archive 
Window Preferences Dialog. For more information on the results of various of 
operations using full and relative paths, see Adding Files to an Archive with 
Drag and Drop .

B.    If the items are dropped onto the Archive File Pane (4) of another archive, 
then the path (directory information) is not stored with the copied/moved 
items.

As noted in the Drag and Drop section, hold down the <Alt> key while dropping to move 
the source files or directory instead of copying them. This will permanently delete the 
source files.
Click on the parts of the window below where appears for more information.

See Also
Adding Files to an Archive
Adding Files to an Archive with Drag and Drop 
Archive Window
Deleting Files from an Archive
Drag and Drop



Extracting Files from an Archive
Full and Relative Paths 



CREATING A NEW ARCHIVE

The create new archive button and Archive|New... menu item are used to create a 
new (empty) archive. When the New Archive dialog is displayed, choose the drive, directory 
and file name for the new archive. If you wish to make a Multi-Volume Archive you must 
choose a removable drive for the archive and place an X in the check box for Multi-volume 
archive.    If you close an empty Archive it will be deleted.    There must be at least one file in 
it or it will no longer exist after you close it.

PLEASE NOTE: you must use preformatted disks when making multi-volume archives.    
Make sure you have a sufficient number of pre-formatted disks handy prior to making a 
multi-volume archive.
Click on the parts of the box below where  appears for more information.

See Also
Archive Window
Adding a Comment to an Archive
Adding Files to an Archive
Deleting Files from an Archive
Extracting Files from an Archive
Making Self-Extracting Archives 
Moving Files Between Archives
Testing the Integrity of an Archive
Windows File Manager 



CREATING A DIRECTORY
The Create Directory... option in the File menu allows you to create a new subdirectory in 
an archive or on a disk. When the Create Directory dialog is displayed, type the name of 
the directory to be created and click the OK button. The directory will be created as a 
subdirectory of the currently selected directory.
Click on the parts of the window below where appears for more information.

See Also
             Working with Directories   



Current Directory

This shows the currently selected directory in the archive or the PROFile Manager window 
under which the new directory will be created.



Date

Place an "X" in this check box to display the column showing file dates and times.



Decryption Password

This edit box is where the user enters the password used to decrypt files that are 
extracted from archives.



Delete Files After Adding

Place an "X" in this check box to permanently delete the selected files from the disk after 
they have been added successfully to the archive. This is a temporary switch and only 
applies to the current operation.



DELETING FILES

 The delete files button and Edit|Delete menu item are used to permanently remove 
files from an archive or from a disk. 
PLEASE NOTE: PROZip has no undo capability so use caution when deleting files from an 
archive or from your disk. 
To delete files:

1. Select the directory or files to be deleted in the Archive Window or PROFile 
Manager Window

2. Click on the delete files button or select the Edit|Delete menu item
3. Respond to the deletion prompts (if any)

See Also
Adding Files to an Archive
Extracting Files from an Archive
Moving Files Between Archives



Delete Originals

Place an X here to automatically and permanently delete the files from the archive after 
they have been extracted. This is a temporary switch and only applies to the current 
operation.



Destination Directory

This is the destination for the extracted files. Either choose the destination directory by 
making the appropriate selections from the drive and directory lists or by typing the 
desired destination into the edit box. PROZip will automatically create any new 
subdirectories.



Directory List

This is a list of directories on the current drive. Click on a directory to change the selected 
directory. Double-click a directory to expand it (show sub-directories) or collapse it (hide 
sub-directories).



DRAG AND DROP
PROZip fully supports Drag and Drop between its PROFile Manager Windows and its 
Archive Windows as well as between two Archive Windows. Files can also be dropped from
outside the program. If a ZIP file (normal or self-extracting) is dropped on PROZip then the
file will be opened. If non-zip files are dropped onto PROZip, you will be prompted for 
whether you wish to create a new archive containing the dropped files.
Normally when files are dragged and dropped, the original files remain; this is called a 
"copy" operation. Alternatively, when the <Alt> key is pressed when dropping files, the 
original files are deleted; this is called a "move" operation.
 is the Drag and Drop cursor showing a "copy" operation is underway.
 is the Drag and Drop cursor showing a "move" operation is underway.

When files or directories are dragged from a PROFile Manager Window (1) to an Archive 
Window    (2) the dragged items are compressed and placed in the archive.
When files or directories are dragged from an Archive Window to a PROFile Manager Window 
the dragged items are extracted from the archive.
When files or directories are dragged from one Archive Window to another Archive 
Window the dragged items are extracted from the first archive and then compressed into 
the second archive.
For more information on using drag and drop for adding and extracting files from archives,
see the topics listed below.

Click on the parts of the window below where appears for more information.

See Also
Adding Files to an Archive with Drag and Drop
Copying and Moving Files between Archives
Extracting Files from an Archive with Drag and Drop



Full and Relative Paths 
Selecting Files 
Working with Directories 



Drive List

This list box displays available drives. To change the currently selected drive, click on the 
arrow to display the available list of drives, then click on the desired drive.



EDIT MENU

Add... Adds files to an archive. See Adding Files to an Archive

Comments... Adds, Deletes, Edits, or Views a comment for an archive. See Adding a 
Comment to an Archive

Delete Permanently removes the currently selected files or directories from an 
archive or drive. See Deleting Files from an Archive

Extract... Unzips the currently selected files from an archive. See Extracting Files 
from an Archive

Verify... Verifies the integrity of an archive. See Testing the Integrity of an 
Archive

Launch Runs an associated program on a selected file. See Launching an 
Application and    File Manager Associations

Select All Selects all files in the currently active Archive or PROFile Manager 
window.



ENCRYPTION AND DECRYPTION

 The Passwords button and Options|Set Passwords... menu item are used to set and 
clear encryption and decryption passwords for archives.
Encrypted (password protected) files can only be extracted from archives when the proper 
password is provided. Encrypted files are shown in the archive windows with a "lock" icon 
rather than the normal page and folder icons. 
To extract encrypted files:

1. Click on the password    button or select Options|Set Passwords...
2. Enter the decryption password in the appropriate box.
3. Extract the files normally.

To encrypt files during addition:
1. Click on the password    button or select Options|Set Passwords...
2. Enter the password for encryption in both the encryption password and 

encryption password verification boxes. Because the password is not shown 
when it is typed, doubly entry of the password prevents a mistake when typing 
the password and subsequent inability to decrypt the protected files.

3 Add the files normally.
The Passwords button will stay depressed to indicate that an encryption password is 
currently in use.    This is to help remind the user that files will be encrypted if they are 
added.
Click on the parts of the window below where

appears 
for more information.



Encryption is useful when you are providing an archive to an individual, and you only want 
that individual to access the files in the archive but the archive may be accessible to others. 
(for example, on a bulletin board). Also, password protection can be useful when you wish to
archive sensitive files on your own machine and others will have access to your machine 
(perhaps across a network). 
Any files added to the archive after the encryption password (and confirmation password) 
are set are automatically encrypted. Files within self-extracting and multi-volume archives 
can be encrypted. The receiver of the archive must set the correct decryption password 
before extracting the files. Obviously, you will have to let the receiver know what 
password you used. 
DO NOT FORGET THE PASSWORD!    There is no way to extract an encrypted file 
without the password, and no way to determine what the password is once lost. Also, it is 
possible to specify different passwords for each file or group of files you add to an archive,
but there is no way to tell that this is the case, and therefore makes extraction of the 
archive much more difficult. It is recommended that you use a single password for all files 
that are encrypted in a single archive.
Passwords can be up to 65 characters long. Longer passwords are more secure, as are 
passwords that contain mixed upper and lower case letters and/or non-letter characters.

The only restrictions on delivering encrypted files anywhere in the world are the same as 
those on the program itself.

See Also
Adding Files to an Archive with Drag and Drop
Extracting Files from an Archive with Drag and Drop



Encryption Password

This edit box is where the user enters the password used to encrypt files that are added to
archives.



Encryption Password Verification

This edit box is where the user enters verification of the password used to encrypt files 
that are added to an archive.



Existing Associations

This list box shows all existing associations. To associate one of the existing programs with
the currently selected extension, select the program from the list box.



Extract File

Select this radio button to extract files from archives when the mouse is double-clicked on 
a file in an Archive Window.



Extract Path

Select the destination directory using the list boxes or type the name of the destination 
directory into this edit box.



EXTRACTING FILES FROM AN ARCHIVE

The extract files button and Edit|Extract... menu item are used to extract (unzip) 
selected files from an archive. To extract files from an archive:

1. Select the files to be extracted from the archive (see Selecting Files).
2. Click on the extract files button or select Edit|Extract...
3. Select the destination directory from the extract files dialog and click OK. To 

create a new directory for the extracted files, type the new directory name in the
extract path edit box.

See Extracting Files From an Archive with Drag and Drop for information on how to use 
drag and drop to extract files.
Click on the parts of the window below where

appears 
for more information.



See Also
Adding Files to an Archive
Deleting Files from an Archive
Drag and Drop
Moving Files Between Archives



EXTRACTING FILES FROM AN ARCHIVE WITH DRAG AND DROP
To extract files or a directory from an archive:

1. Select the desired directory (1) or files (2) from an Archive Window. See Selecting 
Files.

2. Click and drag the selected items and drop them on the desired PROFile Manager 
Window.
A. If files are dropped onto the PROFile Manager File Pane (4), then the files will be 

extracted and placed in the directory currently being displayed.
B. If a directory is dropped on the PROFile Manager File Pane, then all files in that 

directory (and all its subdirectories) will be extracted and placed in the currently 
displayed directory. All directory structure will be lost.

C. If files are dropped on the PROFile Manager Directory Pane (3) then the files will 
be extracted and placed in the directory dropped on.

D. If a directory is dropped on the PROFile Manager Directory Pane then that 
directory (and all its subdirectories) will be extracted and placed in the drop 
directory, preserving the directory structure that was present in the archive.

As noted in the Drag and Drop section, hold down the <Alt> key while dropping to 
move the source files or directory instead of copying them.

NOTE: Dragging and dropping a directory is usually faster than dragging and dropping all 
the files in a directory.
Click on the parts of the window below where

appears 
for more information.



See Also
Adding Files to an Archive with Drag and Drop
Copying and Moving Files Between Archives 
Drag and Drop
Extracting Files from an Archive



File Deletion Options

These options specify the circumstances under which you are prompted when deleting 
files from a PROFile Manager Window. These options apply when deleting files from a 
PROFile Manager Window and when moving files from a PROFile Manager Window to an 
archive during an add operation. Because PROZip does not have an "undelete" function, 
"Always Prompt" is recommended.

Always Prompt Prompt for confirmation before deleting a file
Never Prompt Delete files without confirmation



File List Column Buttons

These column header buttons are used for sorting the files in the list. Click on the button 
corresponding to the desired sort method. To reverse the order of files, click on the button 
again.



FILE MANAGER ASSOCIATIONS
Windows File Manager associations are used to launch programs from PROZip. Files can be
launched either from an archive that is open in PROZip or from a PROFile Manager 
Window. For example, suppose you have an archive that contains a Microsoft Word 6.0 
document with a DOC extension and you have associated files with a DOC extension with 
Word. If you select a file with a DOC extension in an archive then choose View|Launch (or 
click on the Launch button), that file will automatically be extracted to a temporary 
directory, Microsoft Word will be launched and the file will be opened. When you exit 
Word, the temporary file will automatically be deleted by PROZip. 
If you make changes to a file that was launched from an archive in PROZip and then wish 
to save the changes, simply save the file in the normal way from the application using a 
different file name. When launching files from a PROZip PROFile Manager Window, no 
temporary file is created, and the file can be used normally.
PROZip will automatically associate itself with .zip files upon install and startup.    New 
associations can be made for files with extensions for which there is no current 
association. If PROZip fails when it tries to find the a program associated for a given 
extension with a given extension, the user may create a new association. In addition, you 
may select Associate from the File menu to associate a program with an extension at any 
time. In either case, the associations will apply to the Window's File Manager as well as to 
PROZip.
Click on the parts of the window below where

appears 
for more information.



See Also
Setting Preferences 
Setting General Program Preferences 
Setting PROFile Manager Window Preferences 



FILE MENU

New Creates a new archive. See Creating a New Archive and Multi-Volume Archive.

Open... Opens an existing archive. See Opening an Existing Archive
Close Closes an open archive.
Create Directory... Creates a directory in an archive or on a disk. See Creating a 

Directory
Delete Archive Deletes the open archive from the disk.
Rename Archive... Renames an open archive. See Renaming an Archive 

Save Copy As... Saves a copy of the archive to a new location and name 
while keeping the original copy.

Make Self-extracting... Converts the current archive into a self-extracting archive. 
See Making Self-Extracting Archives 

Archive Information... Displays information about the open archive.
Associate... Adds another file association. See File Manager 

Associations

Exit Closes the PROZip program

In addition, the most recently opened archives may be reopened by selecting one from 
the list of files below the File menu items.



Filename

This edit box contains the name of the selected file. Either select a file from the file list 
box or type the name of the file here. It is not necessary to put a .zip or .exe extension on 
the filename. This will be done automatically by PROZip.



File Pane

This pane displays the files in the currently selected directory.



Files

This list box shows available files. Select one or more files from the list.



Files

This list box shows existing files.



File Size

Place an "X" in this check box to show the column containing the sizes of files.



File Types

This list box displays a selection of available file types. Only files of the given type are 
show. To change the current file type, click on the arrow to display the available types, 
then click on the desired type.



Font

Select the desired font from the list box.



Font Preference

The font and point size used are displayed here and may be changed by clicking the 
Select Font button.



Font Sample

A sample of the chosen font is displayed in this area.



FONT SELECTION DIALOG
The font selection dialog is used to choose a font. Select the desired font, style, and size 
then press the OK button.
NOTE: Different fonts can be set for the PROFile Manager and Archive Windows.
Click on the parts of the window below where

appears 
for more information.



Font Size

Select the desired point size from this list box.



Font Style

The font style has no effect.



Full and Relative Path Option

PROZip can save full or relative path information when adding files and directories to 
archives. The choice of using either full or relative paths may be set using the Archive tab 
on the preferences dialog. An example of the difference between the two is as follows:
Let us say you want to archive the MYFILES subdirectory of your PROTEMP directory. If you
click and drag the MYFILES directory from the PROFile Manager directory pane and drop it 
onto the directory pane of an archive one of the two following things will happen:

1.      If full paths are being used then a PROTEMP directory and a MYFILES subdirectory 
are created in the archive and the files are placed in the MYFILES subdirectory. If the
MYFILES subdirectory contains further subdirectories then those subdirectories are 
created as well and all files in them are placed in the archive.

2.      If relative paths are being used then only the MYFILES directory (and any of its 
subdirectories) is created in the archive. The PROTEMP directory is not created.



FULL AND RELATIVE PATHS
PROZip can save full or relative path information when adding files and directories to 
archives. The choice of using either full or relative paths may be set using the Archive tab 
on the preferences dialog. An example of the difference between the two is as follows:
Let us say you want to archive the MYFILES subdirectory of your PROTEMP directory. If you
click and drag the MYFILES directory from the PROFile Manager directory pane and drop it 
onto the directory pane of an archive one of the two following things will happen:

1.      If full paths are being used then a PROTEMP directory and a MYFILES subdirectory 
are created in the archive and the files are placed in the MYFILES subdirectory. If the
MYFILES subdirectory contains further subdirectories then those subdirectories are 
created as well and all files in them are placed in the archive.

2.      If relative paths are being used then only the MYFILES directory (and any of its 
subdirectories) is created in the archive. The PROTEMP directory is not created.



GENERAL PROZIP INFORMATION
The Help|About PROZip... menu item is used to view general information about the 
program, as well as ordering and Technical Support information.

See Also
Help Menu 
Context-Sensitive Help



GETTING STARTED
PROZip is a drag and drop based archiving system. You can create standard ZIP files by 
simply dragging files from one window to another (and extract files the same way).
There are two types of windows in PROZip: PROFile Manager and Archive. When PROZip 
first starts, a PROFile Manager window is automatically displayed (it contains blue file 
folders). This window shows files on your hard disk (it can also show removable and 
network drives). The directories are shown on the left and the files are shown on the right.

    To create a new archive simply click on the new archive button (or choose New... from 
the File menu) and select an archive name using the dialog. This opens an archive window 
(which contains yellow file folders). Similar to your hard disk, archives can have directories. 
The directories are shown on the left and the files are shown on the right.
To add files to the archive, select the desired files in the PROFile Manager window and 
drag them to the Archive window.

    To open an existing ZIP file click on the open archive button (or choose Open... from 
the File menu) and select the desired file.
To extract files from an archive, select the desired files in the Archive window and drag them
to the PROFile Manager window. If you drop them onto the files side of the PROFile Manager 
window (right-hand side), the files will go into the same directory as the files being shown. 
You can drop them into a different directory by dropping them on a directory on the directory
side (left-hand side) of the PROFile Manager window.
All of the above operations behave very similarly to the Windows File Manager drag and 
drop operations. Just as a file can be dragged and dropped between windows to a new 
location in Windows File Manager, files can be added and extracted from archives in 
PROZip.
The README.WRI file contains additional information that was not available at the time of 
the writing of this help file.
This help file serves as the manual for the program. If you require assistance with any of 
the functions of PROZip, simply select the context sensitive help button on the toolbar and
click on the appropriate area of the screen (i.e., menu item, toolbar button or window).
For more information about any of the topics below, simply click on it:

Adding Files to an Archive 
Archive Window 
Drag and Drop 
Extracting Files from an Archive 
Setting Preferences 
PROFile Manager Window 
Working with Directories 
Ordering Information 
License & Copyrights 



Help Button

Click on this button to receive context-sensitive help for the window.



HELP MENU
Contents Displays the Table of Contents for this help file.
Using Help Displays a help file containing instructions on how to use the Windows 

help system.
Getting Started Displays instructions on how to begin using the PROZip program.
About PROZip... Displays General Information about the PROZip program.

See Also
Context-Sensitive Help 



Include Subdirectories

Place an "X" in this check box to add all subdirectories of the chosen directory (as well as 
the chosen directory itself) to the archive.



Including Files in an Add Operation

Only files that match the descriptions here are added to the archives. This is useful 
because whole directories can be selected and added to an archive without archiving 
every file in the directory. For example, suppose you want only executable files in a 
directory to be archived. Type "*.exe *.com *.bat" in the Include edit box, and when you 
archive the directory that contains them, only they will be added to the archive. Beware, 
this can result in not archiving files that you may want archived. Separate each inclusion 
entry with a space in the edit box.



Launch App

Select this radio button to temporarily extract a file and launch an associated program 
when the mouse is double-clicked on a file in an Archive Window. See Launching an 
Application



LAUNCHING AN APPLICATION

To launch an application using File Manager associations, select the file from the 
PROFile Manager or an Archive, then click on the Launch Application button or choose the 
Edit|Launch menu item. You can also launch an application by double-clicking a file in an 
archive or a PROZip PROFile Manager window if your Archive Preferences have been set for 
this action (and not extraction on double-click). 
The launch feature can be used not only to view files but to test programs (i.e., those which 
may be downloaded from a BBS or the Internet) prior to making them a permanent addition 
to your software library. 
The launch feature temporarily extracts the requested file into the temporary directory 
used by PROZip, and then launches the application associated with the specific type of 
file. When you close the application, the extracted temporary file is deleted. PLEASE 
NOTE: an executable that is launched in this way may require other supporting files (such
as DLLs, data files, etc.) to be extracted, therefore it is possible a file may not run properly
when launched in this manner.

See Also
File Manager Associations



LICENSE & COPYRIGHTS
PROZip END USER LICENSE AGREEMENT

By clicking on the "ACCEPT" button or by installing or using this Software (any version of the 
PROZip program, or any part thereof, including any associated files or documentation), you 
agree to be bound by the terms of this Agreement. If you do not agree to all the terms of this 
Agreement, click the "DO NOT ACCEPT" button, or immediately return the product including all 
accompanying materials to the place of purchase for a full refund.

This Agreement has 3 parts. Part I applies to the Extract-Only Version of PROZip. Part II applies 
if you have a license to the full version of the Software. Part III applies to all PROZip software.

PART I - TERMS APPLICABLE TO PROZip
EXTRACT-ONLY VERSION

GRANT OF LICENSE. RT Computer grants you a non-exclusive license to use the Software free of 
charge for an indefinite period of time for evaluation purposes. The Software contains code that 
disables many of its features. You may purchase the personal activation codes that convert the extract-
only Software into the full version of the Software at any time.

DISTRIBUTION OF THE PROZip EXTRACT-ONLY VERSION. Provided that you are distributing the 
Extract-Only Version of PROZip, (without activation codes), and subject to all other terms and 
restrictions in this Agreement, you are hereby licensed to duplicate and distribute exact copies of the 
PROZip Self-Extracting Archive containing the Extract-Only Version of PROZip (PZEO12.EXE), to 
anyone via electronic means, including any BBS or other online service. The file must be distributed in 
its original, unmodified state. 

You are specifically prohibited from distributing any personal activation codes (which convert the 
extract-only version into the full version of the Software), whether purchased or not, to anyone, at any 
time, for any reason.

You may not charge, or request donations for any copy(s) of the Software. You may not distribute the 
Software with any other product(s), commercial or otherwise, including but not limited to software, 
hardware, books, compilation CD's, or the like, without the express written consent of an Officer of RT 
Computer.

DISCLAIMER. RT COMPUTER MAKES NO REPRESENTATIONS ABOUT THE SUITABILITY OF 
THIS SOFTWARE FOR ANY PURPOSE. THE SOFTWARE IS PROVIDED FREE OF CHARGE ON 
AN 'AS IS' BASIS, WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION THE 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO PORTIONS OF 
THIS DISCLAIMER MAY NOT APPLY TO YOU. YOU MAY HAVE OTHER LEGAL RIGHTS THAT 
VARY BY JURISDICTION.

PART II - TERMS APPLICABLE TO THE FULL VERSION OF PROZIP
(INCLUDING WHEN ACTIVATION CODES HAVE BEEN USED TO CONVERT

THE EXTRACT-ONLY VERSION INTO THE FULL VERSION OF THE SOFTWARE)

GRANT OF LICENSE. RT Computer grants you a non-exclusive, non-sublicenseable, non-
transferable, license to use the Software in the manner described below:

You may install and use the Software on a single computer. You are licensed to make one backup or 
archival copy of the Software. If the Software is permanently installed on a hard disk or other computer 
storage device, then the original copy serves as your backup. You may not install your backup or 
additional copies of the Software on any machine if your primary copy is installed unless you are the 



primary user of the computer. In that case, you may also install and use the Software on a portable or 
home computer, only. However, the Software may NEVER be used by more than one person at the 
same time.
You may create and distribute files with the Software, for commercial or non-commercial use, without 
additional license fees.

You may not install the Software on a network or network server unless you have purchased a Multi-
Use, Site, or Network License. In that case, you may make or use additional copies of the Software up 
to the number of copies as you have Licenses.

TRANSFER. You may not rent, lease, sublicense, loan, or transfer the Software to another party.

LIMITED WARRANTY. RT Computer warrants to the license purchaser, that for a period of 90 days 
from the date of delivery or acquisition, (1) the Software will perform substantially in accordance with 
the documentation, and (2) that the media containing the Software, if provided by RT Computer or its 
licensed resellers, is free from defects in materials and workmanship.

RT Computer can not and does not warrant that the operation of the Software will be uninterrupted, 
error free or secure. The security mechanisms within the software have inherent limitations. You alone 
must determine that the Software sufficiently meets your needs. 

RT Computer's entire liability and your exclusive remedy under this limited warranty (subject to your 
returning any damaged media to the place of purchase, postage paid, with a copy of your sales 
receipt) will be limited to, at RT Computer's sole option, the replacement of the Software, or a refund of
the license fee you paid for the Software. Any replacement media or Software will be warranted for the 
remainder of the original warranty period or 30 days, whichever is greater. If the media should fail after 
the warranty period has expired, licensed users may order a replacement by sending the damaged 
media and $10.00 (U.S.) to RT Computer at the address below.    In ALL cases, a $10 (US) retrieval fee
will be assessed to users who lose or misplace personal activation codes.

This Limited Warranty will be void if failure of the media or Software has resulted from accident, abuse,
improper use, or misapplication.

DISCLAIMER. RT COMPUTER DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESSED OR 
IMPLIED, INCLUDING WITHOUT LIMITATION THE WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME JURISDICTIONS DO NOT ALLOW EXCLUSIONS 
OF AN IMPLIED WARRANTY, SO PORTIONS OF THIS DISCLAIMER MAY NOT APPLY TO YOU. 
YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION.

PART III - TERMS APPLICABLE TO ALL PROZip SOFTWARE

COPYRIGHT AND OWNERSHIP. PROZip is copyright 1994-1996 RT Computer or its suppliers. 
DZIP.DLL and DUNZIP.DLL are copyright 1993-1995 InnerMedia. Redistributable portions of Microsoft 
OLE are copyright Microsoft Corporation. All rights reserved.

The Software is owned by, and its structure, organization, and code are the valuable trade secrets of, 
RT Computer or its suppliers. The Software is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the Software like any other copyrighted 
material (e.g., a book or musical recording).

You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or otherwise 
attempt to discover the source code of the Software.

TITLE. This Agreement is not a sale of the original Software or any copy, nor does it grant you any 
intellectual property rights in the Software. Title, ownership rights, intellectual property rights and 
copyrights to the Software, including online and any printed documentation, the original Software and 



any backup copy made by you remain with RT Computer or its suppliers.

TERMINATION. Unauthorized copying of the Software or documentation, or failure to comply with any 
of the terms, restrictions or limitations herein will result in automatic termination of this license and will 
make available to RT Computer other legal remedies.

EXPORT RESTRICTIONS. None of the Software or underlying information or technology may be 
downloaded or otherwise exported, or re-exported (1) into (or to a national or resident of) Cuba, Iraq, 
Libya, Yugoslavia, North Korea, Iran, Syria, or any other country to which the U.S. has embargoed 
goods, or (2) to anyone on the U.S. Treasury Department's list of Specially Designated nationals or the 
U.S. Commerce Department's Table of Deny Orders. By downloading or installing and using this 
Software, you are agreeing to these restrictions and you are representing and warranting that you are 
not located in, under the control of, or a national or resident of any such country or on any such list.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES WHATSOEVER SHALL RT COMPUTER,
ITS SUPPLIERS, OR RESELLERS, BE LIABLE TO YOU OR ANY OTHER PERSON OR ENTITY FOR
ANY DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF 
GOODWILL, COMPUTER FAILURE OR MALFUNCTION, OR ANY OTHER PECUNIARY LOSS), 
ARISING OUT OF THE USE OR INABILITY TO USE THIS RT COMPUTER PRODUCT, EVEN IF THE
COMPANY OR ITS SUPPLIERS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT
APPLY TO YOU.

PURCHASE ORDERS. The acceptance of any purchase order placed by you is expressly made 
conditional on your assent to the terms set forth herein, and not those in your purchase order.

LICENSES AND TRADEMARKS. PROZip is a registered trademark of RT Computer. All other 
trademarks, registered trademarks or products are the property of their respective holders. Mention of 
third-party products is for informational purposes only and constitutes neither an endorsement nor a 
recommendation. RT Computer assumes no responsibility with respect to the performance or use of 
these products.

U.S. GOVERNMENT RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subparagraph (c)(1)(ii) of DFARS 252.227-7013 or subparagraphs 
(c)(1) and (2) of CFR 52.227-19 (a) through (d), as applicable. Contractor/Manufacturer is RT 
Computer Graphics, Inc., PO Box 45300, Rio Rancho, New Mexico 87174.

GOVERNING LAW. This Agreement will be governed by the Laws of the State of New Mexico, and, as 
applicable, by U.S. Federal Laws. The application of the United Nations Convention of Contracts for 
the International Sale of Goods is expressly excluded.

ENTIRE AGREEMENT. This Agreement is the entire agreement between us and supersedes any 
verbal or other communications or advertising with respect to the Software and/or documentation. This 
license may be amended only in writing and only by an Officer of RT Computer.

If the copy of the Software you received was accompanied by a printed or other form of "hard-copy" 
License Agreement, whose terms vary from this Agreement, then the hard-copy License Agreement 
governs your use of the Software.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full 
force and effect.    If you have any questions, please contact in writing:

RT Computer, PO Box 45300, Rio Rancho, New Mexico 87174    U.S.A.



MAKING SELF-EXTRACTING ARCHIVES
A self-extracting archive is one that does not need PROZip to extract files. All of the 
necessary components to extract the files from the archive are included in the file itself. 
These are useful if you want to send an archive to someone who may not have an unzip 
utility. They simply run the program.

PLEASE NOTE: Self-extracting archives made by PROZip are Windows programs. They 
cannot be run from the DOS command line.
To create a self-extracting archive, create a normal archive then select Make Self-
extracting... from the File menu and specify the output name. The name you give the self-
extracting archive should end in .exe.

PLEASE NOTE: the original archive is converted to a self-extracting zip file (.exe). The 
original zip file will no longer exist. If saving the original zip file is desired use the File|Save
Copy As... menu item to create a copy of the zip file before converting it to self-extracting. 

When a self-extracting archive is run, all the files will be extracted to a user specified 
location. To extract individual files, a self-extracting archive can be opened with PROZip 
and used just like a standard archive.
Self-extracting archives can contain encrypted files. If a self-extracting archive contains 
files that have been encrypted then running the self-extracting archive will require a 
password to extract the encrypted files (non-encrypted files can be extracted without the 
password).
Distribution of Self-extracting Archives created with PROZip of commercial software is 
subject to the License Agreement which came with your package.

Click on the parts of the window below where

appears 
for more information.



See Also
             File Menu   

Encryption and Decryption 



MENUS
The menus for PROZip provide access to all functions of the program (including those that 
are not accessible from the Tool Bar). Many menu items also have accelerator keys which 
allow you to access frequently used menu functions with a single key stroke. Accelerator 
keys are shown to the right of the menu items.

See Also
File Menu
Edit Menu
View Menu
Options Menu
Window Menu
Help Menu



MULTI-VOLUME ARCHIVE
Multi-volume archives are zip files that hold more data than can fit on one disk. They can 
only be created on removable drives (such as floppies). During creation of a multi-volume 
zip file PROZip will prompt you to switch disks at the appropriate time. 
Because of the nature of multi-volume archives, only one add operation can be performed 
on them. Once the first set of files has been added, the archive can not be modified in any
way. Also, the archive cannot be renamed or copied because files exist on multiple disks. 
Comments can not be added to multi-volume archives. PROZip shows these archives in 
yellow initially, but then changes the folder and file icons to red after files are added to 
reflect the fact that the archive can no longer be modified.
Because only one operation can be performed on a multi-volume archive, you may need 
to move all files that you wish into a single directory before creating the archive. This can 
be done using the Windows File Manager. Once you have all your files in one place, make 
a new archive by clicking the New button on the Tool Bar or by using the File|New menu 
item on the File Menu. Select a drive and a file name for the archive and make sure to 
place an X in the check box for multi-volume archive. Then drag and drop the desired 
directory from the PROFile Manager to the multi-volume archive.
PLEASE NOTE: In some cases you may attempt to create a multi-volume archive, but the
compressed size of the selected directories and files turns out to be small enough to fit on
a single removable disk. If this happens, PROZip automatically ignores the multi-volume 
option and creates a standard archive on the selected removable drive. You can 
immediately tell that this happened by the fact that PROZip does not change the color of 
the zip file icons to red.
Extracting files from a multi-volume archive works as normal. You will be prompted for the 
correct disk as needed by PROZip. Individual files can be extracted.

See Also
Adding Files to an Archive with Drag and Drop 
Creating a New Archive 



Multi-Volume Archive

Place an X in this check box if you wish to create an archive that spans multiple disks. In 
order to use this option, the disk drive you choose must be a removable disk drive (such 
as a floppy drive, etc.) and all the disks you use must be preformatted.



New Directory Edit Box

This edit box is where the user enters the name of the new directory to create. The name 
must be a valid DOS directory name consisting of no more than 12 characters (an 8 
character name followed by a period and a three character extension if desired).



OK Button

Click on the OK button to proceed with the current action.



On Startup Re-Open Last Archive

Place an "X" in this check box to automatically load (at PROZip startup time) all archives 
that were open when PROZip was last exited.



OPENING AN EXISTING ARCHIVE

The open archive button and Archive|Open... menu item are used to open an existing 
ZIP archive using the traditional open file dialog (shown below). In addition, archives can be 
opened by double clicking on them in a PROFile Manager Window or in the Windows File 
Manager. When an archive is opened, a new Archive Window is created and the contents of 
the archive are displayed.
Standard archive windows are shown with yellow folder and file icons, self-extracting 
archives are shown with green icons, and multi-volume archives that have already had files 
placed in them (are completed) are shown with red icons. Encrypted files are shown with 
locks on the icons.

See Also
Archive Window
Adding Files to an Archive
Copying and Moving Files Between Archives
Deleting Files from an Archive
Drag and Drop
Extracting Files from an Archive
PROZip Windows 
Windows File Manager 



OPTIONS MENU
The Options menu is used to set any of the extensive user preferences in PROZip.

Preferences... Opens the tabbed dialog to set preferences for the 
program. See Setting Preferences.

Set Passwords... Allows you to set passwords used for encrypting and decrypting
files in archives. See Encryption and Decryption.

Reset Preferences... Resets all program preferences to their default settings.



ORDERING INFORMATION
For complete information and instructions on how to obtain the full version of PROZip, see 
the Order.wri file.    It contains all the necessary information, prices, and an order form.

For more information you can reach RT Computer at www.prozip.com or (505) 891-1600 
from 9am to 6pm, Mountain Standard Time, Mondays through Fridays.



PROFile Manager Status Bar Files Selected

This section of the status bar shows information about the files currently selected in the 
PROFile Manager window.



PROFile Manager Status Bar Total Files

This section of the status bar shows information about all of the files in the currently 
selected directory in the PROFile Manager window.



PROFile Manager Deletion Options

These options control when the user is prompted for deleting and moving files.
Always Prompt The recommended setting. Prompts the user before any file is 

deleted from the drive.
Never Prompt Deletes files without prompting when they are moved (not copied)

to archives or when the user chooses to delete the files. Because 
PROZip has no undo feature this option should be used with 
caution.



PROFile Manager Directory Pane

This pane shows the directories on the selected drive. To display the files in the directory, 
click on it. To display the subdirectories of a directory, double-click on it. Double-click on 
the directory again to "collapse" it (remove the display of its subdirectories).



PROFile Manager Drive Tool Bar

To view the files on a different drive, click on the button corresponding to the desired 
drive.



PROFILE MANAGER WINDOW
A PROFile Manager window contains the list of files and directories on a disk. It is very 
similar to the Windows File Manager. It contains a row of selectable drive buttons at the 
top. It also contains two sub-windows:    a directory pane (left side) and a file pane (right 
side). To change the width of the panes, drag the splitter (gray) bar that separates the 
panes in the desired direction. Column header buttons at the top of the file pane can be 
clicked on to quickly sort the files. To reverse sort the files, click on the button again. Files 
may also be sorted by selecting items from the View menu.
More than one PROFile Manager window may be open at one time. Additional PROFile 
Manager windows can be opened using the Window|New PROFile Manager menu item. The
current version of PROZip does not support drag and drop between these PROFile Manager
windows.
Click on the parts of the window below where

appears 
for more information.

See Also
Archive Window
Windows File Manager
Setting PROFile Manager Window Preferences 





PROGRESS DIALOG
The Progress Dialog shows the status of the current operation. Press <Esc> or click on the
Cancel button to stop the operation.
Click on the parts of the window below where

appears 
for more information.



Progress Indicator

This indicator graphically shows the progress of the current operation as a percentage 
completed of the entire operation.



PROZIP WINDOWS
PROZip contains two window types:    PROFile Manager Windows and Archive Windows.

PROFile Manager Windows (#1 below) are used to display files on all existing drives 
(hard, removable, floppy, RAM, CDROM, or network) in a format very similar to the 
Windows File Manager. PROFile Manager Windows are used as the source of files for 
archive add operations and as the destination for extract operations. These windows
are shown with light blue folder and file icons.
Archive Windows (# 2 below) are used to display the contents of ZIP files. They are 
used as the source of files for extract operations and as the destination for add 
operations. Standard archive windows are shown with yellow folder and file icons, 
self-extracting archives are shown with green icons, and multi-volume archives that 
have already had files placed in them (are completed) are shown with red icons.
Folders in the directory pane (left side) of either type of window are shown with a + 
if they contain further sub-directories. Double-clicking on one of these folders will 
expand the tree showing all sub-folders within.

Click on the parts of the window below where

appears 
for more information.



See Also
Archive Window
PROFile Manager Window
Windows File Manager



PROZIP FOR WINDOWS
PROZip for Windows provides a full Drag and Drop archive system using the popular ZIP 
file format. It is used to compress data for archiving or electronic transmission. Typical 
compression ratios are about 2-to-1; however, graphics can often be compressed by a 
factor of 10 or more. The Windows based Drag and Drop support makes archiving easier 
and more intuitive than with the old command-line style of zipping. Any file generated 
with PROZip can be read by PKZIP and vice versa.
PROZip provides two methods of moving/copying files into and out of archives. The 
traditional method is to select the files to operate on, then click on a tool bar button or 
select a menu item for the desired action. For many actions, a dialog will appear to ask for
information needed to complete the operation. For example, to extract files from an 
archive, select the files to be extracted from an Archive Window, then press the extract 
button. A dialog will appear asking for the destination directory.
The Drag and Drop method, however, is easier requiring fewer actions for the same 
operation and providing additional features. For example, to extract files from an Archive 
Window, select the files to be extracted, then drag and drop them onto the appropriate 
location in a PROFILE Manager Window.
In addition to the add and extract operations discussed above, PROZip for Windows 
supports many other features including:

1. Opening multiple archives at once (MDI)
2. Moving and copying files between archives using Drag and Drop
3. Extensive user preferences
4. 10 levels of compression
5. Internal zipping and unzipping (it NEVER launches to DOS)
6. Built-in ability to create self-extracting archives
7. Built-in ability to create archives that span multiple removable disks (floppies)
8. Built-in ability to Encrypt & Decrypt Files (Password Protection)

PROZip does not require the presence of any additional programs (e.g., PKZIP) to use any 
of 
its many features.
DISCLAIMER:    Although PROZip is very stable and every precaution has been taken to 
insure the safety of data used with the program, you should ALWAYS make backup copies 
of important files before using them with ANY program.

See Also
Drag and Drop
Getting Started
Menus
PROZip Windows
Tool Bar



READ ME FILE
The file README.WRI is installed with PROZip and includes information that was not 
available at the time this help file was created.



Remove Association

Use this button to remove an existing association.    PLEASE NOTE: The association will 
be removed for both PROZip and your File Manager.



Reverse Sort

Place an "X" in this check box to reverse sort the files.



RENAMING AN ARCHIVE
Selecting Rename Archive... from the File menu will allow you to change the name and/or 
location of an archive. Simply specify the new name and location for the archive and click 
on the OK button.
To create a new copy of the archive while still retaining the old copy choose Save Copy 
As... from the File menu.
Click on the parts of the window below where

appears 
for more information.



SAVING A COPY OF AN ARCHIVE
Selecting Save Copy As... from the File menu will create a copy of the archive using a new 
name and/or location. Simply specify the new name and location for the archive and click 
on the OK button. 
To rename an archive (rather than creating two copies of it) select Rename Archive... from 
the File menu.
Click on the parts of the window below where

appears 
for more information.



Save Directory Information

Place an "X" in this check box to retain the directory structure of the files in the archive 
when they are added. This is a temporary switch and only applies to the current 
operation.



Selected Compressed File Size

This box shows the total compressed size of the selected files.



Selected File Compression Ratio

This box shows the overall compression ratio of the selected files.



Selected File Size

This box shows the total uncompressed size of the selected files.



Select Font Button

Press the select font button to bring up a dialog where the desired font and point size can 
be selected for Archive windows and PROFile Manger windows.



SELECTING FILES
To select a single file in a PROFile Manager File Window or Archive File Window:

1.    Using the mouse:    Click on the desired file      OR
2.    Using the keyboard:    Use the arrow keys to move the highlight to the desired 
file

To select a range of files in a PROFile Manager File Window or Archive File Window:
1.    Using the mouse:

A.    Click on the first file in the range
B.    Hold down the <Shift> key and click on the last file in the range

2.    Using the keyboard:
A.    Use the arrow and <Page Up>/<Page Down> or <Home> keys to move 

the highlight to the first file in the range
B.    Hold down the <Shift> key and use arrow and <Page Up>/<Page Down>

or <End> keys to move to the last file in the range

To select several non-contiguous files in a PROFile Manager File Window or Archive File 
Window:

1.    Using the mouse:
A.    Click on the one of the desired files
B.    Hold down the <Ctrl> key and click on the remaining files

To select all files in a PROFile Manager File Window or Archive File Window:
1.    Choose the Select All menu item in the Edit menu OR
2.    Press <Ctrl>+A



Self-Extracting Option

Place an "X" in this check box to create self-extracting archives rather than regular 
archives when creating new archives.



SETTING ARCHIVE PREFERENCES
These options for working with archives are selected using the dialog shown below:

· When the user is prompted during add operations
· Whether to use temporary files during add operations
· Which files to include in add operations
· Which files to exclude during add operations
· The compression level to use during add operations
· When the user is prompted during extraction operations
· Whether to verify the validity of the archive after add operations
· When the user is prompted during delete and move operations
· Whether to show archive comments when the archive is first opened
· Whether to use the full or relative path names when adding files

Click on the parts of the window below where

appears 
for more information.



Setting Archive Window Preferences 



SETTING ARCHIVE WINDOW PREFERENCES
The preferences for all Archive Windows are selected using the dialog shown below:

· Which columns of information to display
· Which font and point size to use when displaying the information in the archive
· Which column will be used to initially sort the files in the archive
· How to treat a double-click on a file in an archive 
· What information to display on the title bar

Click on the parts of the window below where

appears 
for more information.



See Also
Font Selection Dialog 



SETTING GENERAL PROGRAM PREFERENCES
The preferences for general features of the PROZip program are selected using the dialog 
shown below:

· Whether to reopen the archives that you had open when you last exited PROZip
· Whether to display the Tool bar
· Which Status bars to show
· Which files to exclude during add operations
· Whether to display Tooltips and the delay before displaying them.
· The path to use for temporary files created by PROZip

Click on the parts of the window below where

appears 
for more information.





SETTING PROFILE MANAGER WINDOW PREFERENCES
The preferences for the PROFile Manager windows are selected using the dialog shown 
below:

· Which columns of information to display
· Which font and point size to use when displaying the information
· Which column will be used to initially sort the files
· When to prompt the user during delete and move operations
· Whether to show the currently selected path in the title bar
· Whether to show hidden and system files

Click on the parts of the window below where

appears 
for more information.



See Also
Font Selection Dialog 



SETTING PREFERENCES
Permanent changes to the user preferences are made using the preferences dialog, which 
can be accessed from the Options Menu. Changes made here affect all currently open 
PROZip windows of as well as all future windows. All preferences may be reset by 
selecting the Reset Preferences item in the Options menu.

See Also
Setting Archive Preferences
Setting Archive Window Preferences
Setting PROFile Manager Window 
Setting General Program Preferences



Show Comments Option

Place an "X" in this check box to automatically view any comments in archives when they 
are first opened. Comments are a good way to remind you exactly what is in an archive 
(e.g., a version number of the files archived).



Show Compressed Size

Place an "X" in this check box to display the total compressed size of files in an archive in 
the title bar.



Show Compression Ratio

Place an "X" in this check box to display the overall compression ratio for an archive in the
title bar.



Show Full Path

Place an "X" in this check box to show the full path to an archive in the title bar of its 
window. If this check box does not contain an "X" then only the filename of the archive is 
shown in the title bar.



Show Hidden and System Files

Place an "X" in this check box to display the hidden and system files. When displayed 
these files are available for archiving. 
PLEASE NOTE: Hidden and system files are usually crucial to the correct operation of 
your computer and should generally not be modified, overwritten or deleted.



Show Inside Window Status Bar

Place an "X" in this check box to display the status bars at the bottom of all Archive and 
PROFile Manager windows.



Show Lowercase

Place an "X" in this check box to display all file and directory names in lowercase for the 
Archive and PROFile Manager windows. If this check box does not contain an "X", the all 
names are shown in uppercase.



Show Main Window Status Bar

Place an "X" in this check box to display the status bar at the bottom of the main PROZip 
window.



Show Path On Title Bar

Place an "X" in this check box to show the current path in the title bar of PROFile Manager 
Windows



Show Tool Bar

An 'X' in this check box will cause the tool bar for the program to be visible.



Show Tool Tips

Place an "X" in Show Tooltips check box to enable helpful "tool tips" (little yellow windows)
to appear when the mouse cursor is moved onto a button on the tool bar and left there. 
The delay between the time the mouse is stopped on a button and the time the tool tip 
appears can range from 0 to 20 (0 is fastest).



Show Uncompressed Size

Place an "X" in this check box to display the total uncompressed size of files in an archive 
in the title bar.



Sort Compressed Size

Select this radio button to sort files by compressed size.



Sort Compression Ratio

Select this radio button to sort files by compression ratio.



Sort Date

Select this radio button to sort files by date/time.



Sort Extension

Select this radio button to sort files by file type (extension).



Sort File Size

Select this radio button to sort files by size.



Sort Name

Select this radio button to sort files by name.



Sort Preference

Select the method for sorting in this group. The files are sorted in increasing order based 
on the method chosen. If there is a tie (e.g., the sort method is File Size and two files have
the same size), the files are sub-sorted based on filename. The order of the files is 
reversed if the Reverse Sort check box has an 'X'.



STATUS BARS
Archive Windows and PROFile Manager Windows have different status bars. See the 
descriptions for the respective windows for more information.



TECHNICAL SUPPORT
Technical support is available to registered users who have a difficulty using PROZip that 
the printed documentation and this online Help file do not address. The technical support 
phone and fax numbers are located in the Help|_About PROZip dialog.
We also welcome your comments and suggestions for future PROZip enhancements.
Prior to contacting us for technical support, please make sure you have the answers ready
to the following questions:

· What version of Windows are you running?
· What is your machine's configuration (CPU, Speed, RAM, Disk space available)
· Are you on a network?
· When does the problem occur? Is it reproducible?
· If an error message was displayed, what did it read exactly?

See Also
Read Me File 



Temporary File Path

The directory specified in this edit box is the directory used by PROZip to store 
intermediate files when performing operations. It is important that sufficient space exist 
on the disk to hold an additional copy of all the files used in an operation. The location of 
this directory is set automatically by PROZip and generally need not be changed. 
However, if you wish to perform archiving of an entire drive, the temp file used by PROZip 
must be located on a different drive.



TESTING THE INTEGRITY OF AN ARCHIVE

The verify archive button and Edit|Verify... menu item are used to perform an internal 
test on the archive to ensure that the files in it are valid (i.e., they can be extracted 
successfully). Files can become corrupt when transmitting across phone lines (modem 
transfers) or when disks are damaged. This function may be used to check for such an 
occurrence.
Also, this operation is often performed after completing the addition of files to an archive to 
verify that the files in the archive can be extracted without error. A single file, multiple files, 
a whole directory or the entire archive may be verified by selecting the desired item and 
choosing this operation.
You can set PROZip to perform verification of an archive after every operation that 
modifies it.

See Also
Setting Archive Preferences 



TOOL BAR
The tool bar contains buttons for frequently used functions. These functions are duplicated
in menus and in some cases with accelerator keys (which are shown on the menus). The 
first set of buttons is used to create a new or open an existing ZIP archive. The second set 
of buttons is used to perform actions on the files in an archive. The third set of buttons is 
used to rearrange the windows in the PROZip program. The button in the fourth set is 
used to access context-sensitive help. The final button is used to exit the program. 
Pausing the mouse cursor over any of the tool bar buttons in PROZip will cause short hints
(small yellow text boxes) called Tooltips to appear. Whether tooltips are shown, and the 
delay time before they appear can be set in the General Program Preferences Dialog.

Click on any of the buttons below to view more information.



Total Compressed File Size

This box shows the total compressed size of all files in the currently selected directory of 
the archive.



Total File Compression Ratio

This box shows the overall compression ratio of all files in the currently selected directory 
of the archive.



Total Files

This box shows the number of files in the currently selected directory of the archive.



Total File Size

This box shows the total size of all files in the currently selected directory of the archive.



Use Temporary Files Option

Place an "X" in this check box to use temporary files when performing add operations. If 
an error occurs during an add operation and temporary files are being used, the original 
archive is restored. If temporary files are not being used and an error occurs, the original 
archive may become damaged. Therefore, it is safer to use temporary files; however, it is 
often significantly faster to add files to archives without creating temporary files.



Verification Options

These check boxes are used to toggle automatic verification of files within an archive and 
the archive as a whole after addition operations are performed on the archives. These 
options cause the addition operations to take longer but the validity of the archive is 
checked. The Verify Files option verifies each file that was added to the archive. Verify 
Archives will verify the entire contents of the archive after an addition operation.



Verify Archives

Place an "X" in this check box to automatically verify the validity of the entire archive after
the completion of each add operation.



Verify Files

Place an "X" in this check box means to verify the validity of files after they are added to 
the archive.



VIEW MENU
Selections in the View menu allow file sorting based on the characteristics of the files.

Sort by Name Sorts the current file list by name (A-Z).
Sort by Extension Sorts the current file list by file extension (A-Z, sub-sorts by

name).
Sort by Date Sorts the current file list by Last Modified/Creation date of 

the file (oldest to newest).
Sort by Size Sorts the current file list by size of the file (smallest to 

largest).
Sort by Compressed SizeSorts the current archive file list by compressed size of files

(smallest to largest).
Sort by Ratio Sorts the current archive file list by percent compressed 

(least to most compressed).
Sort by Attributes Sorts the current file list by attributes.
Reverse Sort Reverses the order of files using the current sort method. 

For example, reverse sorting by name shows the files from 
Z to A. This item is checked when the items are currently 
reverse sorted.

There is a check mark next to the menu item for the current sorting method. This menu is 
used to set the sorting for the active window only and does not change the default sorting
method. To change the default sorting method choose the Options|Preferences... menu 
item and select the Archive Window or PROFile Manager tab.

See Also
Preferences 
Setting Archive Preferences
Setting Archive Window Preferences
Setting PROFile Manager Window Preferences 
Setting General Program Preferences



WINDOW MENU
The Window menu is used to open new PROFile Manager Windows and to arrange the 
PROZip windows.

New PROFile Manager Opens a new PROFile Manager Window.
Cascade Cascades all open windows.
Tile horizontally Tiles all open windows horizontally.
Tile vertically Tiles all open windows vertically.
Arrange Icons Arranges the icons for minimized windows.
Close All Archives Closes all open Archive Windows.

Any open window may be activated by selecting it from the bottom of the Window Menu.

These buttons are used respectively to: tile horizontally, tile vertically, and cascade all of the
open windows.



WINDOWS FILE MANAGER
The Windows File Manager can be used in conjunction with PROZip in the following ways:

1. When PROZip is installed, it associates itself with all ZIP files in the system. To open 
an existing ZIP file with PROZip, simply double-click on it in the Windows File 
Manager.

2. Archives may be opened by dragging them from the Windows File Manager and 
dropping them on the window or icon of a running PROZip program.

3. New archives can be created by dragging non-zip files from the Windows File 
Manager and dropping them on the window or icon of a running PROZip program.

Windows File Manager and the PROZip PROFile Manager do not always know when files 
have been added or deleted using the other program. Therefore, be cautious when using 
these programs together.



Wipe Disks of All Files

Place an X in this check box when you wish to delete all files that already exist on the 
removable disks that you are using for creating a multi-volume archive.



WORKING WITH DIRECTORIES
Similar to having a directory structure on your hard disk, you can create archives that 
contain directories as well. There are two ways to create directories in an archive:

1.    Select the ZIP filename at the top of the Archive Window then choose Create 
Directory... from the File menu and enter the directory name. This will create an 
empty sub-directory into which files may be added. You can also create 
subdirectories by selecting a directory in the Archive window and choosing Create 
Directory...

2.    Drag a directory from the PROFile Manager Window or another archive and drop it 
onto the directory (left-hand) side of the Archive window. This will add the contents 
of the dragged directory (and any of its subdirectories) to the archive.

When dragging a directory from the PROFile Manager window to the Archive window, the 
directory structure created in the archive depends on the current setting of the Full path 
or Relative path preference setting. The value of this setting can be changed by selecting 
Preferences from the Options menu then selecting the Archive Files Tab. If Full path is 
selected, the entire directory structure for the dragged directory is created in the archive. 
If Relative path is selected, only a portion of the path is created. See Drag and Drop for a 
more complete example. Dragging from an Archive window to a PROFile Manager window 
works the same way.
In addition, directories can be created on your hard disks, removable disks, and network 
drives by clicking on a directory then choosing Create Directory... from the File menu and 
entering a directory name. To create a directory during extraction, drag a directory from 
an archive and drop it into a directory in the PROFile Manager window.




